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Environment Management System (EMS)

EMS Overview
Creo is committed to the Environment Management System (EMS) and according to this policy, we 
will keep customers and service engineers informed about the principles of handling company 
products, while emphasizing environmental conservation.
The Triple-R principles are: Reduce, Reuse and Recycle.
Any item that may be recycled should be recycled and any item that can be reused should be reused, 
to reduce the quantities of landfill sent to the local municipalities.

Recycling
Items such as Paper, Plastic, Electronic Parts and Glass should be sent for recycling after use.

Packaging Materials
Packaging Materials will be kept on the customer’s premises. For disposal, send them to a plant for 
recycling Paper, Cartons and Wood.

End of Product Life span
The product should be sent for recycling to a recognized company. 



This Page Is Intentionally Blank.



CSX2000 Color Server Installation Guide v
Table of Contents

About This Installation Guide 1
Who is the Installation Guide for?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Installation Guide Purpose . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Chapter Content and Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Document Conventions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Safety Precautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Power Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Lithium Battery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Selection of Power Supply Cord/Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Cautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Safety Labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Chapter 1 Setting Up Client Workstations 11
Default Network Printers on PC and Macintosh Clients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Defining a Printer on PC Client Workstations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Defining a Printer - Windows NT 4.0  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Defining a Printer - Windows 98 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Defining a Printer - Windows 2000 and ME . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Defining a Printer - WindowsXP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Creating PostScript Files on the PC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Copying PPD from PC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

Defining a Printer on Macintosh Client Workstations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Defining a Printer - Macintosh OS 9 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Defining a Printer - Macintosh OS X (10.1)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Defining a Printer on Unix Client Workstations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Chapter 2 Reinstalling your CSX2000 Color Server 103
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Reinstalling the Operating System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
Configuring the Image Disks (Disk Stripping) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Reinstalling the Services for Macintosh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Reinstalling the Creo Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
The Configuration Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Choosing the Configuration Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Restoring the Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Viewing the Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
Completing the Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

The Configuration Wizard (if configuration recovery fails or is unavailable) . . . . . . . . . . . . . . . . . . . 135



CSX2000 Color Server Installation Guide vi
Choosing the Configuration Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Setting the Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
Configuring the Host Name  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Setting the Date and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Setting the Default Measurement Units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
Configuring the IP Address  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Configuring the Apple Talk Zone  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Configuring the Novell IPX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
Completing the Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146

Format Image Disk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Chapter 3 Upgrading the Software 153
Software Upgrade. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Chapter 4 Administrating the System 157
The Administration Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
General Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160

Changing the Server Name  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Changing the Date & Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Selecting the User Interface Language  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165
Setting the Default Unit of Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166

The Resource Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167
Virtual Printers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
Fonts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
High-Res  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176
VI Elements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
CMYK Emulation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180
User Defined Imposition Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183

Network Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
IPX Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187
IPX Printing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188
TCP/IP Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
AppleTalk Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
Accounting/Message Viewer Log Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
System Disks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
Alert Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
Pre-RIP Preview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198
Default Archiving Path  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 199
PDF Optimization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
Job Batching  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
Default Paper Size . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202

Utilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
View Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204



CSX2000 Color Server Installation Guide vii
Configuration Backup and Restore  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206

Chapter 5 DFE Monitor 211
General Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

Disk Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
Server Attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

Chapter 6 Adding an External SCSI Device 213
Adding an External Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214

Appendix A Novell NDS - Setup and Configuration 227
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Defining Novell NDS Printer Queues in the Novell NDS Tree . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229

Using the Novell NetWare Administrator Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229
Using the Novell NDS PConsole  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246

Configuring IPX Printing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
Installing the Printer Drivers on a Novell Client Using the Adobe PS Application  . . . . . . . . . . . . . . 249
Defining the CSX2000 Color Server as a Novell NDS Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251



This Page Is Intentionally Blank.



Who is the Installation Guide for? 1
About This Installation Guide

Who is the Installation Guide for?
This Installation Guide is intended for CSX2000 Color Server operators and system administrators. 

Installation Guide Purpose
This Installation Guide has been designed to guide you through setting up your CSX2000 Color 
Server. It will also direct you in setting up client workstations to print with the CSX2000 Color 
Server, printing test files, and administrating your CSX2000 Color Server system.



2   About This Installation Guide
Chapter Content and Description

Chapter Contents Description

About About this Installation Guide Installation Guide purpose, contents, 
and document conventions.

Chapter 1 Setting Up Client Workstations Setting up Client Workstations to 
print with the CSX2000 Color 
Server.

Chapter 2 Upgrading the Software Software upgrades on the 
CSX2000 Color Server.

Chapter 3 Reinstalling the System CSX2000 Color Server 
reinstallation by overwrite or system 
partition.

Chapter 4 Administrating the System Setting system parameters

Chapter 5 DFE Monitor DFE Monitor information

Chapter 6 Adding an External Device Adding external hardware

Appendix A Novell NDS Setup and Configuration Configuring the connection between 
a Novell NDS (Novell Directory 
Services) Server and the CSX2000 
Color Server, in a Novell working 
environment.



Document Conventions 3
Document Conventions

Item Purpose Example

User interface 
elements

User interface elements, such as menu 
options and icons, are in bold.

Select New from the File menu.
Click the Expand icon.

Procedures you 
perform

Procedures that you perform appear in a 
numbered list.

1. Connect the machine to the 
main power supply.

2. Turn on your PC.

Single-step procedure Single-step procedures appear with an 
arrow.

Select Remote Station from the 
File menu.

References Book icon precedes reference to another 
book or to another place in the book.

Note Note icon precedes additional 
information.

Caution Caution icon precedes a caution 
message.

Tip Tip icon precedes a tip.

Warning Warning icon precedes a warning 
message.

Emphasized text Use template style to denote importance. As a general user, you are able to 
search for Files and Folders.

Refer to the Safety Precautions 
chapter.

After changing the system 
parameters, you need to reboot 
your system.

Installation must be done by 
authorized service personnel 
only.

For faster processing, use the 
Gallop function.

Danger. Do not open panel!
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Safety Precautions
Safety Precautions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6



6   
Safety Precautions
Power Line

100-240 VAC, 10 A max, 50/60 HZ.

Lithium Battery

The CSX2000 Color Server contains a Lithium battery on the CPU 
board. Only qualified service personnel should replace the battery. The 
following battery specifications fit all CPU configurations.

• Replace only with the same or equivalent type recommended by 
the manufacturer.

• Dispose of the used batteries according to the manufacturer’s 
instructions.

Battery Replacement Requirements

• NOT rechargeable.

• Qualified manufacturers are: Panasonic, Eveready, and Renata

• Model #: CR2032

• Chemical content: LiMnO2

• Mounting mechanism: removable, held by clip

• Replacement method: ESD protection, selection of proper battery 
type and correct orientation of battery during installation required. 

Before opening the unit, ensure that the unit has been switched off and has been 
disconnected from the mains power supply.

 Danger of explosion if battery is incorrectly placed!
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Selection of Power Supply Cord/Connector

The CSX2000 Color Server is supplied with a power supply cord. In 
the event a new power cable or connector type is needed when 
changing from European or American standards for example, refer to 
the following table:

Cautions

Disconnection from the Main Power Supply

The CSX2000 Color Server is equipped with a main power supply 
switch at the rear of the unit (labeled On / Off,) and a power button 
behind the front door. For complete disconnection from the power 
supply, the main power supply must be brought to Off position. 
Switching off only the front power switch will leave some circuits of 
the CSX2000 Color Server energized.

USA & Canada Europe
UL Listed/CSA Certified cord set including:

1. Flexible cord Type SJ, SJE, SJO, SJOO, SJT, 
SJTO, SJTOO, S, SE, SO, SOO, ST, STO, or 
STOO, with minimum 16 AWG, 3 conductors.

2. A min. 12-Ampere parallel blade grounding 
type attachment plug.

3. IEC 320 type appliance coupler.

1. 3-conductors HAR type cord. The cord set 
used must be approved for the country in 
which the equipment is installed.

2. 1.25 mm2 (minimum) conductor cross-
section.

3. Grounding-type attachment plug.

4. IEC 320-type appliance coupler.

The AC Drawer provides protective grounding for the rest of the machine. 
Disconnect from Electrical Supply before dismantling AC Drawer.

For keeping the machine electrically safe after service, ensure that the AC 
Drawer and Fan Drawer (located above the AC Drawer) are secured to the 
frame by all required screws. 

If you remove the left front service cover of the unit, you will be exposed to 
electrical and mechanical hazards. The front ON / OFF switch is connected to 
high voltage. Rotating fan blades are also exposed. Disconnect the unit from 
electrical supply prior to removing the cover.
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Static Electricity Safety Precautions

Take the following precautions whenever handling an electronics 
board, disk drive and memory modules, since they can be extremely 
sensitive to ESD (Electro Static Discharge).

1. It is recommended to use a field service grounding kit (chain, mat 
and wrist strap) when handling these above-mentioned electronic 
components.

2. After removing the component from the system or from its 
protective wrapper place it on the grounded anti-static mat and not 
on a carpet or any other unshielded surface.

3. After removing a board from a station, store it in an anti-static bag.
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Safety Labels

The following safety labels are found on the CSX2000 Color Server.

Safety Label Location

Top, side and bottom right rear of 
the CSX2000 Color Server.

Bottom right rear of the 
CSX2000 Color Server.

Bottom right rear of the 
CSX2000 Color Server.



This Page Is Intentionally Blank.



11
Chapter 1

Setting Up Client 
Workstations
Default Network Printers on PC and Macintosh Clients 12
Defining a Printer on PC Client Workstations . . . . . . . . 14
Defining a Printer on Macintosh Client Workstations  . . 81
Defining a Printer on Unix Client Workstations . . . . . . 102



12 Chapter 1  Setting Up Client Workstations
Default Network Printers on PC and Macintosh Clients 
For Macintosh and PC networks, the CSX2000 Color Server provides 
three default network printers, known as virtual printers.

Virtual printers contain preset workflows that are automatically applied 
to all print jobs processed with that virtual printer. There is no 
requirement to reset job settings for each job. This functionality results 
in greatly increased printing efficiency.

CSX2000 Color Server preset virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and printed to 
the printer through the CSX2000 Color Server.

• ProcessStore 
Files sent to this printer are automatically processed and printed to 
the Storage Folder of the CSX2000 Color Server. You can later 
submit the jobs to be printed, or change the parameters of a job and 
resubmit it for processing.

• SpoolStore
Files sent to this printer are automatically stored in the CSX2000 
Color Server's Storage Folder until the print operator submits them 
for processing and printing.

An additional default network printer is provided for Macintosh 
networks. 

• FontDownLoader
This is a special network printer used with Macintosh clients to 
download fonts. The FontDownLoader functions as a 
communications port, sending messages between the 
FontDownLoader program and the CSX2000 Color Server. It is 
not possible to send files via the FontDownLoader, only fonts.

The job (print) parameters set in the job override the parameters set in the virtual 
printer.
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The CSX2000 Color Server enables you to select which virtual printer 
to print to. It also allows you to define new virtual printers, with 
printing workflows tailored to your specific job requirements.

For more information refer to the CSX2000 Color Server Printing Guide.
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Defining a Printer on PC Client Workstations
The CSX2000 Color Server can print to the following PC client 
workstation running: Windows 98/ME and Windows NT 4.0/2000 and 
XP. The CSX2000 Color Server network printers are defined using the 
Windows Add Printer Wizard - Network Printers. 

Defining a Printer - Windows NT 4.0
To define a CSX2000 Color Network Printer through the Windows Add 
Printer Wizard:

1. Click the Start button, point to Settings, and click Printers.

2. Double-click the Add Printer icon. 
The Add Printer Wizard appears.

When adding a new CSX2000 Color Server virtual printer to a client workstation, 
there is no need to install the CSX2000 Color Server PPD and Adobe PS printer 
driver separately. They are installed automatically through the Windows Add 
Printer Wizard.
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3. On the window that appears, select Network Printer Server. 
Click Next.

4. Browse the network to where the CSX2000 Color Server is 
configured. Double-click the server name. 
A list of the network printers is displayed.

The CSX2000 Color Server is provided with three network printers: 
ProcessPrint, ProcessStore and SpoolStore.
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5. Select one of the network printers (for example, ProcessPrint), and 
click OK.

6. When prompted to set this printer as the default printer, leave the 
default as No and click Next. 
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7. The CSX2000 Color Server network printer is now successfully 
installed. Click Finish to complete the setup.

8. Repeat the above process to install additional network printers.
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To define a CSX2000 Network Printer through the Network 
Neighborhood:

1. Browse your network to the desired network printer.

2. Double-click on the network printer icon.

3. The network printer is defined on your PC client workstation.

4. Repeat the above process to install additional network printers.

Configuring an LPR Printer on Windows NT 4.0

The following procedure describes how to configure an LPR printer in 
Windows NT 4.0 for printing to the CSX2000 Color Server.

The following items must be installed and configured on the Windows 
NT 4.0 client workstation (Server or Workstation version) before you 
begin:

• TCP / IP protocol

• Microsoft TCP / IP Printing service 

• Latest Adobe PS Printer Driver (You can download the latest 
version free from www.adobe.com.)
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To define an LPR Printer:

1. From the Start menu, select Settings>Printers.

2. From the File menu, select Server Properties.
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3. Select the Ports tab and then click the Add Port button.
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4. From the list of Available Printer Ports list, select LPR Port, and 
then click the New Port button.

5. Type the exact name of the CSX2000 Color Server (this field is 
case-sensitive), for example, CSX2000_F in the Name or address 
of server providing lpd: field. Then type the exact name of the 
Virtual Printer you wish to print to (you can view the exact name
of the printer on the CSX2000 Color Server, under: 
Admin>Resource Manager>Virtual Printers). In this example 
the Virtual Printer name is CSX2000_F_ProcessStore. Click OK.

.
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6. Close the Printer Ports dialog box.
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7. Click OK in the Print Server Properties dialog box.

8. Define the LPR printer using the Adobe PostScript Printer driver 
application. See the following procedure.
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To define an LPR Printer using the Adobe PostScript Driver:

1. Launch the Adobe PostScript Driver application (you can 
download this application from Adobe's Web site at 
www.adobe.com).
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2. When the Welcome message appears click Next.
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3. Click Accept to accept the license agreement (read license 
agreement first).



Defining a Printer on PC Client Workstations 27
The following window appears.

4. Select It is directly connected to your computer (Local Printer), 
then click Next.
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The following window appears.

5. Select the LPR port you defined earlier on, for example, 
CSX2000_F_ProcessStore, and then click Next.
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The following window appears.

6. The next step is to configure the printer with the CSX2000 Color 
Server PPD. The CSX2000 Color Server PPD is located in a 
shared folder on the CSX2000 Color Server. Click Browse.



30 Chapter 1  Setting Up Client Workstations
The following window appears.

7. Click the Network button and browse to your CSX2000 Color 
Server.
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The following dialog box appears.

8. Once you have located the CSX2000 Color Server, double-click on 
the server icon and then double click on the Utilities folder. Then, 
click OK.
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The following dialog box appears.

.

9. Double click on the PPD folder and then select the CSX2000 Color 
Server PPD.

10. Click OK.
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The following dialog box appears.

11. In the list of Printer Models select the CSX2000 Color Server PPD 
(CSX2K2_0.ppd) that you just added and then click Next.
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The following window appears.

12. Select Not Shared and then click Next.
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The following window appears.

13. Type a name for the printer which you will be able to identify on 
the client workstation, for example CSX2000 ProcessStore. Select 
Yes if you want to print a test page (recommended) or select No, 
then click Next.
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The following window appears.

14. Click Install to install the LPR printer with the CSX2000 Color 
Server PPD. When prompted to configure the printer, click Yes and 
then click Next.
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The following window appears.

15. Click Yes.
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The following dialog box appears.

16. Configure the printer according to your specifications and then 
click OK.
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The following window appears.
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17. Click Finish to complete the setup.
The network printer now appears in the Printers window.

The new LPR printer is now listed with your other printers on the 
WindowsNT client workstation. You are now ready to print to the 
CSX2000 Color Server using LPR.
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Defining a Printer - Windows 98

To define a CSX2000 Color Server network printer through the Windows 
Add printer wizard:

1. Click the Start button, point to Settings, and click Printers.

2. Double-click the Add Printer icon. 
The Add Printer Wizard appears.

When adding a new CSX2000 Color Server network printer to a client 
workstation, there is no need to install the CSX2000 Color Server PPD and 
Adobe PS printer driver separately. They are installed automatically through the 
Windows>Add Printer Wizard.
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3. Click Next. 
The following window appears.
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4. Select Network printer and click Next.
The following window appears.
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5. Type the network path or the queue name of your printer. If you 
don’t know its name, click Browse to view available network 
printers.

.

6. Select one of the network printers (for example, ProcessPrint).
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7. Click Next. 
The following window appears.

8. When prompted to set this printer as the default printer, leave the 
default as No. 
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9. Click Next. 
The following window appears.

10. Select Yes to print a test page.
The CSX2000 Color Server network printer is now successfully 
installed. Click Finish to complete the setup.

11. Repeat the above process to install additional virtual printers.

To define a CSX2000 Network Printer though the network neighborhood:

1. Browse your network to the desired network printer.

2. Double-click on the network printer icon.
The network printer is defined on your PC client workstation.

3. Repeat the above process to install additional network printers.
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Defining a Printer - Windows 2000 and ME

To define a CSX2000 Color Server network printer though the Windows 
Add Printer Wizard:

1. Click the Start button, point to Settings, and click Printers.

2. Double-click the Add Printer icon. 
The Add Printer Wizard appears.

When adding a new CSX2000 Color Server network printer to a client 
workstation, there is no need to install the CSX2000 Color Server PPD and 
Adobe PS printer driver separately. They are installed automatically through the 
Windows Add Printer Wizard.
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3. Click Next. 
The following window appears.

4. Select Network printer.
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5. Click Next. 
The following window appears.
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6. Type the printer name and click Next. If you don’t know its name, 
click Next to browse for a printer. 
The following window appears.

7. Select one of the network printers (for example, ProcessPrint).
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8. Click Next. 
The following window appears.

9. When prompted to set this printer as the default printer, leave the 
default as No. 
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10. Click Next. 
The following window appears.

The CSX2000 Color Server network printer is now successfully 
installed. 

11. Click Finish to complete the setup.

12. Repeat the above process to install additional network printers.

To define a CSX2000 Color Server network printer through Network 
Neighborhood:

1. Browse your network to the desired network printer.

2. Double-click on the network printer icon.
The network printer is defined on your PC client workstation.

3. Repeat the above process to install additional network printers.
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Defining a Printer - WindowsXP

To define a CSX2000 Color Server network printer though the Windows 
Add Printer wizard:

1. On your Windows desktop, click the Start menu and point to 
Printers and Faxes.

When adding a new CSX2000 Color Server network printer to a client 
workstation, there is no need to install the CSX2000 Color Server PPD and 
Adobe PS printer driver separately. They are installed automatically through the 
Windows Add Printer Wizard.
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The Printer and Faxes window appears.

2. From the Printer Tasks, select Add a printer.
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The Add Printer Wizard appears.

3. Click Next to setup one of the default CSX2000 Color Server 
network printers.
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The Local or Network window appears.

4. Select A network printer, or a printer attached to another 
computer and then click Next.
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The Specify a Printer window appears.

5. Select Browse for a printer and then click Next.
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The Browse for Printer window appears.

6. Browse to the CSX2000 Color Server and double-click it to 
display the list of network printers.
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7. Select the printer you wish to setup and click Next.
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The Default Printer window appears.

8. If you would like this printer to be the default printer on your 
computer, select Yes. Otherwise, select No.
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9. Click Next.
The following window appears.

You have now successfully completed setting up one of the 
CSX2000 Color Server network printers in Windows XP.

10. Click Finish to close the wizard.
The CSX2000 Color Server network printer is added to your 
printer list.

To define a CSX2000 Color Server network printer in WindowsXP through 
the Network:

1. Browse your network to the desired network printer.

2. Double-click on the network printer icon.
The network printer is defined on your PC client workstation.

3. Repeat the above process to install additional network printers.
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Creating PostScript Files on the PC

The following procedures describes how to create PostScript files 
using the CSX2000 from the client workstation. This is useful when 
you are not connected to the CSX2000 Color Server and you need to 
distribute jobs for printing on the CSX2000 remotely or on external 
media. These file can then be imported to the CSX2000 Color Server 
for printing.

To Create a PostScript File:

1. In your application (for example, MS Word), select Print.

2. In the Print window of your software application, select Print to 
File.

Print to File from MS Word.
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3. Click Print.
A PostScript file has now been created. 

To define a Print to File printer locally:

1. Launch the Adobe PostScript Driver application (The application 
is found on CD#3 in the Utilities folder, or at Adobe's Web site at 
www.adobe.com).
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2. When the Welcome message appears on the screen click Next.
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3. Click Accept to accept the license agreement (read license 
agreement first).
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The following window appears.

4. Select It is directly connected to your computer (Local Printer), 
then click Next.
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The following window appears.

5. Select the FILE: Local Port and then click Next.
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The following window appears.

6. The next step is to configure the printer with the CSX2000 Color 
Server PPD. The CSX2000 Color Server PPD (CSX2K2_0.ppd) is 
located in a shared folder on the CSX2000 Color Server. Click 
Browse. 
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The following window appears.

7. Click the Network button and browse to your CSX2000 Color 
Server.
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The following window appears.

8. Once you have located the CSX2000 Color Server, double click on 
the server icon and then double click on the Utilities folder. Click 
OK when you are done.
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The following window appears.

9. Double click on the PPD folder and then select the CSX2000 Color 
Server PPD (CSX2K2_0.ppd).

10. Click OK.
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The following dialog box appears.

11. In the list of Printer Models select the CSX2000 Color Server PPD 
(CSX2K2_0.ppd), that you just added and then click Next.
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The following window appears.

12. Select Not Shared and then click Next.
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The following window appears.

13. Type a name for the printer which you will be able to identify on 
the client workstation, for example CSX2000. Select Yes if you 
want to print a test page (recommended) or select No, then click 
Next.
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The following window appears.

.

14. Click Install to install the Print to file printer with the CSX2000 
Color Server PPD. When prompted to configure the printer, click 
Yes and then click Next.
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The following window appears.

15. Click Yes.
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The following dialog box appears.

16. Configure the printer according to your specifications and then 
click OK.
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The following window appears.
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17. Click Finish to complete the setup.
The printer now appears in the Printers window.

You are now ready to print *.ps and *.prn files. Once printed, these 
files can be imported and printed on the CSX2000 Color Server.
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Copying PPD from PC

It is necessary to use the CSX2000 Color Server PPD to create PS files 
to send to the CSX2000 Color Server. The CSX2000 Color Server 
PPD should therefore be copied and distributed to the customer. 

To copy the PPD from the CSX2000 Color Server for distribution on a 
diskette or by e-mail:

1. Double-click the Network Neighborhood icon on the desktop.

2. Browse to the location of the CSX2000 Color Server station (for 
example, CSX2000).

3. Select the CSX2000 Color Server and its Utilities folder.

4. Select the PPD folder.

5. Copy the CSX2k2_0.ppd file to a diskette or send it by e-mail to 
the customer.



Defining a Printer on Macintosh Client Workstations 81
Defining a Printer on Macintosh Client Workstations
The CSX2000 Color Server can print to the following client 
workstation running: Macintosh OS 9 and OS X (10.1).

Before setting up a CSX2000 Color Server network printer, you need 
to install the CSX2000 Color Server PPD on the Macintosh 
workstation. 

Defining a Printer - Macintosh OS 9
To copy the CSX2000 PPD:

1. From the Apple menu, select Chooser.

2. Select AppleShare and browse the network to where the CSX2000 
Color Server is configured.

3. Select the CSX2000 Color Server (for example, CSX2000) and 
click OK.
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4. Log in as "Guest" and click Connect.

5. Select the Utilities folder and click OK.

6. Select the Utilities volume located on the desktop. 

Do not select the check box. otherwise it will mount with every reboot.
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7. Select the PPD folder.

8. Copy the CSX2K2_0.ppd file to the System Folder>Extensions 
Printer Descriptions folder.
The CSX2000 Color Server PPD is now installed in the Printer 
Descriptions folder. It is ready to be configured with one of the 
CSX2000 Color Server's network printers. 
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To set up a CSX2000 Color Server network printer on Macintosh OS 9:

1. From the Apple menu, select Chooser.

2. Select LaserWriter and browse the network to where the 
CSX2000 Color Server is configured.

3. Select one of the CSX2000 Color Server's network printers (for 
example, CSX2000_ProcessStore) and click Create. The 
following window appears.

4. The system should automatically locate the CSX2000 PPD and 
configure the printer. If it does not, click Select PPD.
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5. From the list of Printer Descriptions, select CSX2K2_0.ppd. 
Click Select.
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The printer is now a CSX2000 Color Server network printer, and is 
set up on the Macintosh workstation. 

If you have the Desktop Printer Spooler extension enabled, a 
printer icon appears on the desktop.

6. Repeat the above process to install additional printers.

This icon can be used when downloading PS files to the CSX2000 Color 
Server.
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Defining a Printer - Macintosh OS X (10.1)

Before you begin you need to install the CSX2000 Color Server PPD 
to your Macintosh. The following procedure describes the 
recommended location where to copy the CSX2000 PPD, however it 
can be copied to any folder on your Macintosh.

To copy the CSX2000 PPD:

1. From the Go menu, select Connect to Server.
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The Connect to Server dialog box appears.
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2. Browse the network and select the required CSX2000 Color 
Server.

3. Click the Connect button.
The Login dialog box appears.

 

4. Select Guest and then click the Connect button.
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The following dialog box appears.

 

5. Select the CSX_Utilities folder and then click OK.
The CSX_Utilities folder is mounted on your desktop.

6. Double-click the CSX_Utilities folder on your desktop.
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7. Then double-click the PPD folder. 

 

8. Copy the CSX2K2_0.ppd from the CSX2000 Color Server to your 
Macintosh hard disk. It is recommended to copy it by dragging and 
dropping from the CSX2000 Color Server to the 
Library>Printers>PPDs folder on your Macintosh.

 



92 Chapter 1  Setting Up Client Workstations
To set up a CSX2000 Color Server network printer on Macintosh OS X:

1. From the Go menu, select Applications.

 

2. Open the Utilities folder.
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3. Double-click the Printer Center icon. 
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The Printer List window appears.

4. Click the Add Printer button.
The following dialog box appears.
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5. Select AppleTalk as the connection type.

6. Browse the network to the location where the CSX2000 Color 
Server is located, and then select the CSX2000 Color Server 
printer. 

7. Click the Printer Model pop-up menu and select Other…

 

If you would like to use the LPR protocol instead, refer to “To Configure an 
LPR Printer” on page page 98.
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8. Browse to the folder to which you have copied the CSX2000.PPD 
and then select the CSX2K2_0.ppd.

9. Click the Choose button to assign the CSX2K2_0.ppd to the 
selected CSX2000 Color Server network printer.
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The following dialog box appears.

10. Click the Add button to add the new printer to the Printer List.
The new printer is displayed in the Printer List window.
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To Configure an LPR Printer:

1. Follow the “Setting up a CSX2000 Network Printer in Mac OS X” 
procedure, till step 5.

2. In the Printer List window, select LPR Printers using IP as the 
connection type.
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3. In the LPR Printer's Address field, type either the TCP/IP 
address or hostname of the CSX2000 Color Server. See the 
following example.

4. Clear the Use Default Queue on Server check-box.

5. In the Queue Name field, type the full name of the CSX2000 
Color Server network printer, for example “CSX7_ProcessPrint” 
(case-sensitive).

6. From the Printer Model pop-up menu, select Other...
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7. Browse to the folder to which you have copied the CSX2000.PPD 
and then select the CSX2K2_0.ppd.

8. Click the Choose button to assign the CSX2K2_0.ppd to the 
selected CSX2000 Color Server network printer.
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The following dialog box appears.

9. Click the Add button to add the new printer to the Printer List.
The new printer is displayed in the Printer List window.
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Defining a Printer on Unix Client Workstations
To define an AIX 4.2.1 printer for printing through LPR:

1. On your UNIX client (for example, AIX 4.2.1) - enter SMIT and 
select the following sequence: 

Print Spooling>Add a Print Queue>remote>Standard 
processing.

2. In Name of QUEUE to add - type the name of the print queue to 
be used on your UNIX client (use a logical name to recognize the 
remote printer).

3. In HOSTNAME of remote server - type the hostname of the 
remote server where the printer is defined (for example, 
CSX2000).

4. In Name of QUEUE on remote server - type the exact name of 
the print queue defined on the remote server (for example, 
ProcessPrint).

5. Click OK to define the printer.

Ensure that printer name defined on the remote server contains no more 
than 20 characters. Unix is case sensitive.
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Overview
This chapter describes the methods for reinstalling your CSX2000 
Color Server by complete overwrite or by system partition. It describes 
how to install the Windows NT operating system, the Creo Software 
Application, and the configuration of the system using the 
Configuration Wizard. In addition, there is a section on reinstalling the 
services for Macintosh, for customers that use multiple AppleTalk 
zones.

The CSX2000 Color Server is delivered to the customer site preloaded 
with the following software and configuration:

• Windows NT 4.0 Server

• MS Service Pack 6.0a high encryption

• Internet Explorer 5.5 high encryption

• Creo Application Software

• Adobe Acrobat 4.0

• Default network settings (hostname, IP address, network services 
and protocols)

It may, however, become necessary, for example after a system crash, 
to reinstall the system at the customer’s site.

The reinstallation is mostly unattended. User interaction is needed only 
for entering the OS license number and the computer hostname, for 
rebooting the computer when requested, for inserting the final 
application CD and for the Configuration Wizard. The reinstallation of 
the system requires two CD's: NT Server Fast Install V 2.0 CD #1 and 
CSX2000 Color Server Application SW CD#2.
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The following table outlines the CSX2000 Color Server disk 
configuration:

There are two methods for reinstalling the system:

• Creo Software Complete Overwrite Installation: This procedure 
replaces the entire system disk, the operating system partition, 
Creo application, and the user partition (Disks C: and D:) 
Complete Overwrite should be performed only when installing a 
new system.

• Creo Software Preservation Installation (System Partition 
Overwrite): This procedure replaces only the operating system 
partition (Disk C:). System Partition Overwrite should be 
performed when the Windows NT Server operating system is 
corrupt and needs to be reinstalled.

C: Windows NT + application D: Spool + Shared + Output directory 
+APR HighRes files

Image Storage
Image Storage

Notes:

1. Backup the CSX2000 Color Server configuration before loading the operating 
system to enable the restoration of customer settings.

2. It is recommended to back up your configuration on a floppy disk in case the 
system crashes.

3. Determine if VIPP or any other Xerox/Creo supported application is loaded on 
the CSX 2000 Color Server. Such applications will have to be reloaded after 
this reinstall is completed.

This option will delete all the files. Make sure to back up any important 
customer files before selecting this option.
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Reinstalling the Operating System
Before reinstalling, ensure the following information is available:

• CD S/W pack

• Computer name (for example, CSX1)

• TCP/IP information (for example, DHCP = yes) 

• OEM Windows NT product ID#

• Gateway, WINS address, and DNS information

• AppleTalk Zone

• IPX information

To reinstall the operating system:

1. Power up your computer.

2. Place the System Software “NT Fast Install” CD-ROM # 1 in the 
CD-ROM drive.

3. Restart the computer after inserting the CD-ROM (from the Start 
menu, select Shutdown>Restart the Computer).

4. Wait until the MS-DOS 6.22 Startup Menu appears.

5. Use the arrows to select one of the following installation options 
and press ENTER.

• Creo Software Complete Overwrite Installation

• Creo Software Preservation Installation (System Partition 
Overwrite)

• DOS Prompt

The system starts copying the files.

6. After a few minutes, the system prompts you to remove the CD-
ROM from the drive and reboot.
Press CTRL+ALT+DEL to reboot.

For more details, refer to the Xerox Installation and Planning Guide.

If you are already logged into your system and the CSX2000 Color Server 
workspace is open, exit the workspace and proceed to step 2.
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7. When the Windows NT Server Setup Registration screen appears 
enter the 20-digit Product ID that comes with the Windows NT 
Server manual. Click Next.

8. In the Computer Name screen, enter the Station name for the 
CSX2000 Color Server, for example CSX2000_1, and click Next.

9. Click Next on the Windows NT Setup screen.
The installation process begins.

10. At the end of the installation, the system reboots a number of 
times. You are asked to insert the Application Software CD 
(CD #2). 

11. Insert CD #2 into the CD-ROM drive, and configure the Image 
Disks, refer to the following section.

If you do not have a DHCP server, a message may appear to inform you 
that the DHCP client could not obtain an IP address. Click NO to not 
receive future DHCP messages.
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Configuring the Image Disks (Disk Stripping)
The following procedure should be performed if the diagonal or angled 
lines do not appear on the two Image Disks (Disks 1 and 2, in 600/700 
MHz CPU, or Disks 0 and 1, in 1 GHz CPU). 

To configure the Image Disks:

1. Click the Start button, and follow the path: 
Programs>Administrative Tools>Disk Administrator.

If the following message appears “Disk Administrator has determined that this is 
the 1st timeDA has been run, or that one or more disks have been added to your 
computer since DA was last run. System configuration will now be updated” 
Click OK.
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The following message appears.

2. Click OK.
The following Confirm message appears.

3. Click Yes.
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The Disk Administrator window appears.

4. Right-click on one of the Image Disks, and from the menu select 
Delete. Then click Yes to confirm.

Note that the screen captures in this procedure reflect the disk status using 
a 1 GHz CPU. If the CSX2000 Color Server has a 600/700 MHz CPU, the 
disk order is different: the first Disk is the System disk and the next 2 Disks 
are the Image Disks.
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5. Right-click on the second Image Disk, and from the menu select 
Delete. Then click Yes to confirm. 
The Disk Administrator window is now displayed as follows.

6. To create a stripe set, press and hold CTRL while you left-click both 
Image Disks.

Do not manipulate the System Disk: 
Disk 0 in 600/700 MHz CPU, or Disk 2 in 1 GHz CPU.
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7. Right-click one of the Image Disks and from the menu, select 
Create Stripe Set.
The following window is displayed.

8. Click OK.

9. Right-click one of the Image Disks and from the menu, select 
Assign Drive Letter. 

10. In the window that is displayed, select Do not assign a drive 
letter.

For 18GB drives the total size of the created stripe set is different.
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The Disk Administrator window is displayed as follows.

11. Close the Disk Administrator window.
The Confirm message is displayed.
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12. Click Yes to save the changes.
The following message is displayed.

13. Click Yes to continue.
The following message is displayed.

14. Click OK to continue.
The following message is displayed.

15. Click OK to restart your computer. Next, reinstall the services for 
Macintosh.
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Reinstalling the Services for Macintosh
The Services for Macintosh are automatically installed during the NT 
installation. However, the unattended installation of the Services for 
Macintosh does not support multiple Apple talk zones. Therefore, If 
you use multiple Apple Talk zones it is necessary to first remove the 
unattended installation of the Services for Macintosh and then reinstall 
the service manually. 

In addition Services Pack 6a should be reinstalled.

Before you begin this procedure, you must have the Windows NT Server CD.
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To remove the Services for Macintosh:

1. Restart the CSX2000 Color Server.

2. When the CSX2000 Color Server is up, close the CSX2000 Color 
Server Software Application.

3. Right-click the Network Neighborhood icon, and from the menu 
select Properties.
The Network dialog box appears.
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4. Select the Services tab.
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5. From the Network Services list, select Services for Macintosh, 
then, click the Remove button. 
The following Warning appears.

6. Click Yes to continue and then click the Close button to close the 
Network dialog box.
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The Bindings Review process indicator appears, followed by the 
NWLink message.

7. Click No.
The Network Settings Change message appears.

8. Click Yes to restart your computer, for the changes to take effect.
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To manually install the Services for Macintosh:

1. When the CSX2000 Color Server is up, close the CSX2000 Color 
Server Software Application.

2. Insert the Windows NT Server CD (the original CD was delivered 
with the NT Server license), into the CD-ROM drive.

3. Right-click the Network Neighborhood icon, and from the menu 
select Properties.
The Network dialog box appears.

Close the NT setup window if it appears.
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4. Select the Services tab.
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5. Click the Add button.
The Select Network Service window appears.

6. From the Network Service list, select Services for Macintosh, 
and click OK.
The following message appears.

7. Verify the path is E:\I386 and click the Continue button.
The files are copied from the specified location.
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8. Click the Close button in the Network dialog box.
The following message appears.

9. Click No.
The Bindings Review process indicator appears, followed by the 
Microsoft AppleTalk Protocol Properties dialog box.
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10. Click OK.
The following message appears.

11. Click Yes to reboot and promptly remove the NT Server CD.
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To install Service Pack 6a:

1. When the CSX2000 Color Server is up, close the CSX2000 Color 
Server Software Application.

2. Insert the NT Server Fast Install CD # 1 into the CD-ROM drive.

3. On the CSX2000 Color Server desktop, double-click My 
Computer and browse to E:\Files_nt\Sp6. Then, double-click 
Sp6i386.exe.
The Service Pack 6a files are then extracted, and the Windows NT 
Service Pack Setup window appears.
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4. Select Accept the License Agreement, and clear the Backup files 
check-box. Then click the Install button.
The files are copied to your system and the following message 
appears.

5. Remove the NT Server Fast Install CD # 1 from the CD-ROM 
drive and click the Restart button.

6. Next, reinstall the Creo Software Application.
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Reinstalling the Creo Application
To reinstall the Creo application:

1. Place the Application Software CD in the CD-ROM drive, and 
close the CD-ROM Drive. 

2. In the SPIRE splash screen that appears, click Start.
The Adobe Acrobat setup begins.

3. After the Adobe Acrobat setup is complete, the CSX2000 Color 
Server installation starts. When the License Agreement window 
opens, click Yes to continue the CSX2000 Color Server 
installation.

4. When the installation is complete, remove CD #2 from the CD-
ROM drive.
The system restarts automatically.

5. After the computer restarts, the Configuration Wizard appears. 
Proceed to Section The Configuration Wizard on page 128, if a 
configuration backup is available. Proceed to Section The 
Configuration Wizard (if configuration recovery fails or is 
unavailable) on page 135 if there is no back up and the system 
configuration must be done manually.

Wait for the LED on the CD-ROM drive to stop blinking before proceeding.
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The Configuration Wizard
The CSX2000 Color Server Configuration Wizard automatically 
appears after the installation is complete. Follow the steps of the 
wizard to complete the CSX2000 Color Server Configuration recovery. 
If configuration recovery is impossible, refer to “The Configuration 
Wizard (if configuration recovery fails or is unavailable)” on page 135.

Choosing the Configuration Type
To choose a configuration type:

1. If no configuration file was saved before the software reinstall, 
select First time Configuration and click Next. Then proceed to 
“The Configuration Wizard (if configuration recovery fails or is 
unavailable)” on page 135.
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2. If a configuration file is available, select DFE Configuration 
recovery, and then click Next.

If you received the message “Error in default configuration”, click OK and 
go to step 2 in Section Restoring the Configuration on page 130.
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Restoring the Configuration
To restore the configuration:

1. If you would like to restore the default configuration, select 
Default Configuration. If you received the message "Error in 
default configuration", or if you want to use a different 
configuration file than the default, choose Select Configuration 
and click browse. Locate the desired configuration file and then 
click OK.
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2. Click the Start Recovery button.
The Restore Configuration dialog box appears.

3. By default, all categories are selected. If you do not want to restore 
certain categories, clear the required selections.

4. Click OK.
The following message appears.

5. Click Yes if you would like the restored files to replace the current 
ones. Click No if you do not want the restored files to replace the 
existing files.

When restoring the configuration all the custom tables/sets will be added to 
the system (for example imported user-defined imposition templates, new 
virtual printers, downloaded fonts etc.
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After the recovery is complete, a confirmation message is 
displayed.

6. Click OK to finish the recovery and to return to the Step 2 
Recovery window.

Or:
Select Print with Low Res to print the job with the low resolution 
images.

7. In the Use APR Mask from area, select High Res to use the 
masking data contained in the high resolution file (if such data 
exists).
Or:
Select PS Image (low resolution) to use the masking data 
contained in the low resolution image file.
Or:
Select Both to use only the masking data common to both the high 
resolution and the low resolution image files (i.e., if the images 
defined by the two sets of masking data overlap, then this 
overlapping area is RIPped). click Next.

This mode, which is quicker, is suitable for layout proofing.
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Viewing the Configuration
To view the configuration:

Click Close to exit the View Configuration window.
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Completing the Configuration 
To complete the configuration: 

1. Click Finish.
The CSX2000 Color Server Application workspace appears on 
your screen.

2. Close all open applications and from the Start menu, choose 
Shutdown. Then, select Restart the Computer, and click Yes. 
The CSX2000 Color Server restarts.

3. If your site uses multiple AppleTalk zones, reinstall the Services 
for Macintosh. Refer to Section Reinstalling the Services for 
Macintosh on page 115.
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The Configuration Wizard (if configuration recovery fails or is 
unavailable)

If there is no backup configuration in your system, you need to perform 
the following steps to configure your system.

Choosing the Configuration Type

The CSX2000 Color Server Configuration Wizard automatically 
appears the first time you power up the CSX2000 Color Server. 

To choose the configuration type:

Verify that First Time Configuration is selected and click Next.
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Setting the Language 
To set the language:

Select the required interface language, and click Next.
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Configuring the Host Name

The CSX2000 Color Server contains a default Computer Name 
(Hostname) set from the factory. Check with your System 
Administrator if the computer’s name needs to be changed.

To configure the host name:

The Hostname is taken from the computer name you entered during the NT Fast 
Installation, see section Reinstalling the Operating System on page 106. 
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1. Verify that the correct host name is displayed and click Next. 
Otherwise, click the Change button.
The Network dialog box appears.
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2. Click the Change button.
The Identification Changes window appears.

3. In the Computer Name field, type the new name for the computer. 
If you would like to change the Workgroup or the Domain in 
which your computer appears, type the new name in the 
corresponding field.

4. Click OK.

5. Click Next to continue.

Important Note: do not change the Workgroup or Domain unless 
instructed.

When prompted to restart your computer, click No, (since you will be 
prompted at the end of the Configuration Wizard to restart your system).
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Setting the Date and Time
To set the date and time:

1. Check that the Date and Time are set correctly and click Next. 
Otherwise, click the Change button.
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The Date/Time Properties dialog box appears.

2. Set the date and time correctly and click OK.

3. Then click Next.
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Setting the Default Measurement Units
To set the default measurement units:

Select the default measure unit you want to use, and click Next.
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Configuring the IP Address
To set the IP address:

1. Verify that the displayed IP Address is correct and click Next. 
Otherwise, click the Change button and type the new IP address.

2. If prompted to restart your computer, click No, (since you will be 
prompted at the end of the Configuration Wizard to restart your 
system.) then, click Next to continue.

The CSX2000 Color Server is set to DHCP server configuration.

For more details on how to get the IP or DHCP (also subnet mask and 
default gateway) information, refer to the Xerox Installation and Planning 
Guide.
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Configuring the Apple Talk Zone

This option enables you to change the AppleTalk network zone that 
your CSX2000 Color Server will appear in.

To set the AppleTalk zone:

Verify that the displayed Apple Talk zone is correct and click Next. 
Otherwise, click the Change button and select the new zone.

This option only applies to networks that contain Macintosh computers.

If there are problems finding the desired AppleTalk zone and multiple zones 
exist, refer to Section Reinstalling the Services for Macintosh on page 115 
and reinstall the Macintosh Services.
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Configuring the Novell IPX

This step is relevant only for those customers who have a Novell 
Network running IPX protocol. If you don’t have this type of network, 
click next in the Novell IPX window.

To configure the Novell IPX:

1. In the Tree Name and Context Name boxes, type the exact Tree 
name, and full Context path.

2. Click Next.
Further information about configuring the connection between the CSX2000 
Color Server and a Novell NDS Server, in a Novell working environment, is 
provided in the CSX2000 Color Server Installation Guide.
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Completing the Configuration
To complete the configuration:

1. After the installation is complete, the View Configuration window 
is displayed.
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2. Click Close.
The following window is displayed:

3. Click Finish to complete the First-time setup.
When the backup is complete, the following message appears.
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4. Click OK.
The CSX2000 Color Server workspace appears on your screen.

5. Close the CSX2000 Color Server application and format the Image 
disks. Refer to Section Format Image Disk on page 149.

6. Close any open applications and from the Start menu, select 
Shutdown. Then, select Restart the Computer, and click Yes. 

The CSX2000 Color Server workspace automatically appears on 
your screen.
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Format Image Disk
To format the Image disks:

1. From the Windows task bar, execute the following sequence: 
Start>CSX2000>CSX2000 Tools>Format Image Disks.

The following screen appears.

2. Close the applications and windows, then click OK to continue.

3. Click OK to format the Image Disks in Scitex File System format.

The following screen appears. 

All files in the Storage Folder will be erased. 

Note: Before you begin you should make sure that all applications are closed.
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4. Click Yes to continue and format the Image Disks, otherwise select 
No and backup your files before formatting the Image Disks.

5. If you selected Yes in the previous step, the format process begins.
The following screen appears:
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6. When the formatting is complete the following message appears. 
Click OK and then restart your computer.
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Software Upgrade

To update the software:

1. Before you begin upgrading the CSX2000 Color Server software 
you should backup your current configuration (refer to 
“Configuration Backup and Restore” on page 206).

2. Exit the CSX2000 Color Server: from the Job menu select Exit, 
and then wait for the Creo icon to disappear from the windows task 
bar on the right hand side.

3. Before updating the system to a new version, removal of the 
current version is required. From the Start menu, select Settings > 
Control Panel and then double-click on the Add/Remove 
Programs icon.

4. Select CSX2000 and then click Add/Remove.

5. Click Yes when prompted to remove the CSX2000 Color Server 
application. 

6. Click Yes to All when prompted to remove all shared files, and 
then click Yes to confirm.

Note: This section does not reload the operating system, if you need to reload 
Windows NT, see “Reinstalling the Operating System” on page 106 for details.
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7. At the end of the removal procedure, the following window 
appears.

8. Click OK when the uninstall is complete.

9. Click OK when the following message appears. Click OK also if 
an Uninstall message appears.

10. Close the Control Panel window.

11. Click OK to close the Add/Remove Programs Properties window.
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12. From the Start menu, select Shutdown > Restart the Computer, to 
restart the CSX2000 Color Server. Click Yes to confirm your 
choice.

13. Once the CSX2000 Color Server has rebooted insert the CSX2000 
Color Server Application Software CD#2 and browse the CD-
ROM to CSX2000_2.0 folder, and locate the Setup.exe file. Then, 
double-click this file to run Setup. If a Services or driver fail 
message appears, click OK.

14. Click Yes to the accept the licence agreement. 

15. Click Yes if any other messages appear.

16. When the setup is complete, click Finish to reboot the CSX2000 
Color Server. 

The Software upgrade is now complete.
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The Administration Window
The CSX2000 Color Server contains several utilities that enable you to 
manage your system. 

The following system utilities are available:

• General Setup

• Resource Manager

• Network Setup

• Preferences

• Utilities

To access these utilities, click the Admin button on the Pathways 
panel.
Or:
From the Tools menu, select Administration.
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The Administration window appears.
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General Setup
The General Setup utility enables you to change the system 
parameters, such as the hostname of your CSX2000 Color Server, the 
system’s date and time, the user interface language.

To open the General Setup utilities:

1. Open the Administration window and double-click General Setup 
to expand the folder.
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Changing the Server Name
To change the server hostname:

1. In the General Setup folder, double-click Server Name.
The Network dialog box appears.
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2. In the Identification tab, click the Change button.
The Identification Changes dialog box appears.

3. In the Computer Name field, type a new name for the computer. 

4. If you want to change the Workgroup or the Domain in which 
your computer appears, type a new name in the corresponding 
field.

The system prompts you to reboot your computer for the new 
settings to take effect. 

5. Click No if you want to change other system parameters or click 
Yes and reboot your computer.

Important Note: do not change the Workgroup or Domain unless 
instructed to.
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Changing the Date & Time
To change the system date and time:

1. In the General Setup folder, double-click Date&Time.
The Date/Time Properties dialog box appears.

2. In the Date & Time tab, select your local time settings.
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3. Select the Time Zone tab and set the correct time zone.

4. Click OK.
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Selecting the User Interface Language
To select the user interface language:

1. In the General Setup folder, double-click Language.
The Language dialog box appears.

2. Select the interface language you would like to use, and click OK.
The system prompts you to reboot your computer for the new 
settings to take effect. 

3. Click No if you want to change other system parameters or click 
Yes and reboot your computer.
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Setting the Default Unit of Measurement
To set the default unit of measurement:

1. In the General Setup folder, double-click Units.
The Units dialog box dialog box appears.

2. Select the required system measurement unit and click OK.
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The Resource Manager
The Resource Manager utility enables you to manage the virtual 
printers, add and delete fonts, manage the high-res files used for APR 
and manage your VI elements. In addition, you can create and manage 
CMYK emulations and import user defined imposition templates.

To open the Resource Manager utilities:

1. In the Administration window, double-click Resource Manager to 
expand the folder.
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Virtual Printers

A virtual printer is a printer published on the network with specific 
parameters set for processing and printing on the CSX2000 Color 
Server. The CSX2000 Color Server contains a mechanism that 
automatically installs the published virtual printers on your client 
workstation with the PPD and suitable printer driver. 

The CSX2000 Color Server is predefined with three virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and printed to 
the printer through the CSX2000 Color Server.

• ProcessStore 
Files sent to this printer are automatically processed and printed to 
the Storage Folder of the CSX2000 Color Server. You can later 
submit the jobs to be printed, or change the parameters of a job and 
resubmit it for processing.

• SpoolStore
Files sent to this printer are automatically stored in the CSX2000 
Color Server's Storage Folder until the print operator submits them 
for processing and printing.

If a job that is sent from the client, or downloaded to a particular virtual 
printer, contains preset parameters from the PPD, these options 
overwrite the parameters set in the virtual printer for that job. The 
'Printer Default' options defined in the PPD use the default parameters 
set for that particular virtual printer.
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Adding a new Printer

To add a new printer:

1. In the Resource Manager folder, double-click Virtual Printers.
The Virtual Printers dialog box appears.

2. Click the Add New Virtual Printer button.
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The Add New Virtual Printer dialog box appears.

3. In the Printer Name field, type a name for the new printer you 
want to add.

4. From the Based on list, select an existing printer with similar 
settings. Modify the settings you want to change or add to the new 
printer.

5. In the Comments field, type any comment regarding the virtual 
printer parameters (optional).

6. The Publish the printer on the network check-box is selected by 
default. Clear the check-box if you do not want to publish the 
printer on the network.

7. Edit the Job Parameters of your new virtual printer. Refer to 
“Editing an Existing Printer” on page 171.

8. Click Save. 
The new printer appears in the printer list.

If you don't edit the job Job Parameters, the settings of the new virtual 
printer are taken from the printer on which it was based.
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Editing an Existing Printer

To edit an existing printer:

1. In the Virtual Printers dialog box, select a printer from the list and 
click the Edit Virtual Printer button.
Or:
Right-click one of the existing printers and select Edit Virtual 
Printer. 
The Virtual Printer dialog box appears.
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2. Click Edit.
The Parameters window appears.

In the Parameters window, you can edit all job parameters. In each 
tab the left pane lists the parameters and the right pane displays the 
options for the selected parameter. 
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3. Select the required parameters and change their settings according 
to your requirements.

4. Click OK to return to the Virtual Printer dialog box.

5. Click Save to save the new settings.

For additional details, refer to The CSX2000 Color Server Printing Guide, 
Chapter 3, Basic Printing Workflow, Setting Job Parameters. 
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Deleting an Existing Printer

To delete an existing printer:

1. In the Virtual Printers dialog box, select a printer from the list and 
click the Delete Virtual Printer button.
Or:
Right-click one of the existing printers and select Delete Virtual 
Printer. 
The Delete Logical Printers message appears.

2. Click Yes to delete the designated printer.

Do not delete default printers (ProcessPrint, ProcessStore, SpoolStore).
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Fonts
To manager fonts on the CSX2000 Color Server:

1. In the Resource Manager folder, double-click Fonts.
The Fonts Handler dialog box appears.

2. To set the default font, select a font in the font list, and click the Set 
As Default button.

3. To delete a font, select the font you want to delete, and click 
Delete.

4. Click OK to confirm the changes and to return to the 
Administration window.

5. To add new fonts to the CSX2000 Color Server, copy the new 
font/s to the C:\CSX2000\General\RIP\Font folder.
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High-Res

The High Res utility in the Resource Manager enables you to organize 
your high-resolution files. You can add or delete files, copy files from a 
local hard disk, from the network, or from an external media (for 
example, CD-ROM or floppy). The default shared folder dedicated to 
high-res files resides in D:\Shared\HighRes.

To organize your high-res files:

1. In the Resource Manager folder, double-click Hi-Res. 
Windows Explorer displays the contents of your High-Res folder.

2. You can add files to the High-Res folder; delete files from it, and 
copy files from external media.
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VI Elements

The VI (Variable Information) Elements utility enables you to organize 
VI elements on your system. 

To open the VI elements Viewer window:

1. In the Resource Manager folder, double-click VI Elements.
The Elements Viewer dialog box appears.

Your VI jobs are displayed on the left pane. The right pane lists the 
elements associated with your jobs, and a thumbnail of a selected 
element.
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To delete VI elements: 

Select the elements you want to delete, and click Delete.

To archive your VI elements for future use:

1. Click the Archive button. 
The Save As dialog box appears.

-

2. Choose the required archive location for the VI elements, and click 
Save.
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To retrieve VI elements from archive:

1. From the Job menu, select Retrieve from Archive.
The Retrieve dialog box appears.

2. Double-click the folder where your VI elements have been 
archived.
Or:
Select the folder and click the Open button.
The archived VI elements are retrieved.

The archived job name is replaced by the original job name when the job is 
retrieved.
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CMYK Emulation

The CMYK Emulation utility enables you to create new CMYK 
emulations based on ICC profiles of various output devices and add 
them to the CSX2000 Color Server pre-installed CMYK emulation. In 
addition, you can rename or delete existing emulations.

Adding a CMYK Emulation

To add a CMYK Emulation:

1. In the Resource Manager folder, double-click CMYK 
Emulation.
The CMYK Emulation dialog box appears.
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2. Click the Add Color Emulation button.
The Add CMYK Emulation dialog box appears.

3. Click Browse to locate the ICC profile of the device you want to 
emulate. Once a profile is selected, confirm or modify the 
emulation name, and click the Create Emulation button.

A new CMYK emulation transformation, based on the selected 
ICC profile, is created and listed in the CMYK emulation list.

Renaming an Existing CMYK Emulation

To rename an existing CMYK emulation:

1. In the CMYK Emulation dialog box, select a CMYK emulation 
from the list and click the Rename Emulation button.
Or:
Double-click the emulation you want to rename. 
The Rename dialog box appears.

2. Type in a new name for the emulation, and click OK.
The emulation with the new name is listed in the CMYK emulation 
list.
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Deleting an Existing CMYK Emulation

To delete an existing CMYK emulation:

In the CMYK Emulation dialog box, select a CMYK emulation 
from the list and click the Delete Color Emulation button.
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User Defined Imposition Template

The User Defined Imposition Template utility enables to import and 
manage, user defined imposition templates (created in a stand-alone 
application) in the CSX2000 Color Server. 

Importing User Defined Imposition Templates

To import a user defined imposition template:

1. In the Resource Manager folder, double-click User Defined 
Imposition Template.
The Template Manager dialog box appears.

2. Click the Import Template button.
The Import Template dialog box appears.
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3. Browse to the location of the user defined template and click the 
Import button.

4. Select the lock job ticket check-box if you would like the template 
to be locked so that no imposition parameters may be applied (in 
the Job Parameters window).

5. Repeat the above procedure to add additional user defined 
imposition templates.

Renaming a User Defined Imposition Template

To rename an existing user defined imposition template:

1. In the Template Manager dialog box, select a user defined 
imposition template from the list and click the Rename button.
Or:
Right-click a user defined imposition template you want to rename 
and from the menu select Rename.
The user defined imposition template name becomes active.

2. Type a new name for the user defined imposition template.
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3. Click outside the name box of the user defined template.
The user defined imposition template with the new name is listed 
in the user defined imposition template list.

Deleting a User Defined Imposition Template

To delete an existing user defined imposition template:

In the Template Manager dialog box, select a user defined 
imposition template from the list and click the Delete button.
Or:
Right-click a user defined imposition template you want to delete 
and from the menu select Delete.
The selected user defined imposition template is deleted.
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Network Setup
The Network Setup utility enables you to change settings in the IPX, 
TCP/IP and in the Apple Talk Setup.

To open the Network Setup utilities:

In the Administration window, double-click Network Setup to 
expand the folder.

Before changing the network settings, consult your System Administrator.
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IPX Setup
To change the IPX network settings:

1. In the Network Setup folder, double-click IPX Setup.
The NWLink IPX/SPX Properties dialog box appears.

2. To change the frame type, click Manual Frame Type Detection 
and select a frame type from the Frame Type list, then click Apply.

3. Click OK to return to the Administration window.
You are prompted to restart your computer. 

4. Click No if you need to make more changes, or Yes to reboot.
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IPX Printing

IPX printing enables the CSX2000 Color Server to act as a job server 
for the Novell queue. A job server checks each assigned queue at a 
specified interval, taking care of jobs on a first-in, first-out basis. Once 
a job is processed, its associated file is deleted from the queue 
directory.

To setup the CSX2000 Color Server IPX parameter:

1. In the Network Setup folder, double click IPX Printing.
The IPX Printing dialog box appears.

2. Type the name of the exact name of the Novell Tree and full 
Context path, as defined by the Novell NDS Administrator.

3. Click OK.

Using this procedure requires further setup by the network administrator. 
Refer to “Novell NDS - Setup and Configuration in the CSX2000 Color 
Server Installation Guide.
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TCP/IP Setup

The CSX2000 Color Server is predefined with a default IP address. 
The TCP/IP option enables you to change this IP address and other 
TCP/IP settings.

To change the TCP/IP network settings:

1. In the Network Setup folder, double-click TCP/IP Setup.
The Microsoft TCP/IP Properties dialog box appears.

Before changing the network settings, consult your System Administrator.
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2. Change the IP Address by selecting Obtain an IP address from a 
DHCP server or Specify an IP address. If you select the latter, 
you need to type the data for the IP Address, the Subnet Mask and 
the Default Gateway fields.

3. After making the changes, click Apply; then click OK.
You are prompted to restart your computer. 

4. Click No if you need to make more changes, or Yes to reboot.
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AppleTalk Setup

The AppleTalk Setup utility enables you to change the AppleTalk zone 
in which your CSX2000 Color Server is located.

To change the AppleTalk network settings:

1. In the Network Setup folder, double-click AppleTalk Setup.
The Microsoft AppleTalk Protocol Properties dialog box appears.

If there are problems finding the desired AppleTalk zone and multiple zones 
exist, refer to Section “Reinstalling the Services for Macintosh” on 
page 115, and reinstall the service for Macintosh.
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2. In the General tab, from the Default Zone list, select the 
AppleTalk zone for your computer, and click Apply.

3. Click OK.
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Preferences
The Preferences utility enables you to change several settings such as 
the log file generated by the Accounting and Message Viewer 
applications and the System Disks threshold. In addition you may 
define the appearance of the alert messages, the number of booklets in 
the VI View Options and set the Default Archiving Path and Default 
Paper Size.

To open the Preferences utilities:

In the Administration window, double-click Preferences to expand 
the folder.
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Accounting/Message Viewer Log Setup

By default, all the jobs that were handled during the past 90 days are 
listed in the CSX2000 Color Server Accounting window, and all the 
jobs that were handled during the past 56 days are listed in the 
CSX2000 Color Server Message Viewer.

This utility enables you to specify different values for how long 
information remains before being overwritten.

To setup the accounting/message viewer:

1. In the Preferences folder, double-click Accounting/ Message 
Viewer Log Setup.
The Accounting/ Message Viewer Log Setup dialog box appears.
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2. From the Accounting Log Setup area, and in the Message Viewer 
Log Setup areas, type the required values to specify how long 
information remains before being overwritten. 

3. To remove all the existing information from the windows, 
whenever desired, click the Clear Log Now button.

4. Click OK to confirm the changes you made.

For additional details, refer to The CSX2000 Color Server Printing Guide, 
Chapter 7, Job Accounting.
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System Disks

When the Printer or User Disks reach a pre-defined threshold (usually 
of 256 MB), RIP is suspended and the system provides a warning 
message. The RIP will resume automatically only after disk space is 
available. 

To set the system disks threshold:

1. In the Preferences folder, double-click System Disks.
The System Disks dialog box appears.

2. Set the minimum free disk space required for RIP.
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Alert Messages

The Alert Messages utility enables you to select whether the Alerts 
window will open automatically, or not, when an error occurs.

To set the alert window settings:

1. In the Preferences folder, double-click Alert Messages.
The Alert Messages dialog box appears.

2. If you would like the Alerts window to appear whenever an error 
occurs, select Launch Alerts window automatically on new 
error (default).
If you would like to open the Alerts window upon selection only, 
select Launch Alerts window on user selection only.

3. Close the Alert Messages dialog box.
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Pre-RIP Preview
To define the Pre-RIP preview:

1. In the Preferences folder, double-click Pre-RIP Preview.
The Pre-RIP Preview dialog box appears.

2. In the PS Preview area, specify your choice: 

• If you would like to save the file as PDF - select the first choice.

• If you would like to return to the original PS file, select the 
second option.

3. In the VI Job Preview area, select the required number of booklets 
for pre-RIP preview.
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Default Archiving Path

The Default Archiving Path utility enables you to select a default path 
for archiving jobs. Once the path is set, and Archive is selected from 
the job menu, the archive window browser will be directed to the 
predefined path.

To define the default archiving path:

1. In the Preferences folder, double-click Default Archiving Path.
The Archiving Path dialog box appears.

2. Click the Browse button.
The Choose Default Path dialog box appears.

3. Browse to the required archiving location for your job (s) and 
Click OK.
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PDF Optimization

The PDF optimization utility enables optimizes the RIP process of 
PDF files with repeated elements (which are marked as repeated in the 
PDF file) and consequently significantly decreases the processing time.

To enable PDF Optimization:

1. In the Preferences folder, double-click Pre-RIP Preview.
The PDF Optimization dialog box appears.

2. Select Enable PDF Optimization if you would like to optimize 
the RIP of PDF files.

3. Click OK.
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Job Batching

The Job Batching utility enables you to print several jobs with the same 
page parameters, one after the other without the cycle down, and 
consequently save production time.

To set Job Batching:

1. In the Preferences folder, double-click Job Batching.
The Job Batching dialog box appears.

2. Select Enable Job Batching to print jobs with the same page 
parameters, one after the other without the cycle down.
Or:
Select Disable Job Batching to disable the printing of jobs with 
the same page orientation, one after the other and enable cycle 
down.
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Default Paper Size

When a PDL file does not contain any page size information (usually 
set by the PPD), the RIP uses a pre-defined default size. You can set 
this default size, and provide better control of the default RIP size.

To set the default paper size path:

1. In the Preferences folder, double-click Default Paper Size Path.
The Default Paper Size dialog box appears.

2. From the Size list, select the required page size, then click OK.
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Utilities
These utilities enable you to view and back up the configuration of 
your CSX2000 Color Server.

To open the system Utilities:

In the Administration window, double-click Utilities to expand the 
folder.
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View Configuration

The View Configuration utility enables you to view the configuration 
of your CSX2000 Color Server and to print it to any printer on the 
network connected to your CSX2000 Color Server. In addition you 
may save the configuration in the network or export it to an external 
media.

To view the configuration:

1. In the Utilities folder, double-click View Configuration.
The View Configuration window appears.
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2. Click Print to print the configuration.
The Print window appears.

3. From the Printer list, select one of the defined printers and click 
OK.

4. If you would like to save the configuration click the Export 
button.
The Save As dialog box appears.

5. Browse to the required location and click the Save button.

6. Click Close to close the View Configuration window.



206 Chapter 4  Administrating the System
Configuration Backup and Restore

The Configuration Backup utility enables you to backup your 
CSX2000 Color Server configuration to a local hard disk, to a network 
drive or to an external media (such as a CD-ROM drive), connected to 
the CSX2000 Color Server.

Configuration Backup

To backup the configuration of your CSX2000 Color Server:

1. In the Utilities folder, double-click Configuration Backup.
The Configuration Backup dialog box appears.
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2. In the Backup Configuration to area, the default location for the 
backup configuration (C:/CSX2000/General/Configuration) 
appears.
If you would like to specify a different path, click the Browse 
button and browse to a different directory path for the backup.

3. Click the Start Backup button.

Configuration Restore

To restore the configuration of your CSX2000 Color Server:

1. In the Restore Configuration from area, the default configuration 
location is displayed.(C:/CSX2000/General/Configuration).
If you would like to select a different path, click the Browse button 
and browse to a different directory path for the restore.

2. Click Start Recovery.

You may also backup to an external media.

The last path will be saved and displayed to the path box. If the backup was 
made to an external media, the displayed path will be the default: 
C:/CSX2000/General/Configuration.

Notes:
1. The configuration files name will always be: "SpireConf.Cab" (Cabinet 

file.)
2. You may also restore the configuration from an external media.
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The Restore Configuration dialog box appears.

3. By default, all categories are selected. If you do not want to restore 
certain categories, clear the selections.

4. Click OK.
The following message appears.

When restoring the configuration all the custom tables/sets will be added to 
the system (for example imported user-defined imposition templates, new 
virtual printers, downloaded fonts etc.
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5. Click Yes if you would like the restored files to replace the current 
ones. Click No if you do not want the restored files to replace the 
existing files.

6. When the process is complete, click OK to close the Configuration 
Backup dialog box.

Note that the Restore Configuration date is updated in the Configuration 
Backup dialog box.
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General Information
You can view the main settings of the DFE and their status. The DFE 
provides general information about the following:

• Disk usage 

• Networking setup

• Virtual printers

Access this view-only screen by:

Selecting the DFE bitmap on the workspace status panel
Or:
Selecting the DFE status from the tools menu

Disk Usage

You can receive on-line visual statuses for disk capacity and disk 
usage.

Disk Usage displays the usage of both User Disk and Image Disk. For 
each disk data is displayed regarding: 

• Used disk

• Free disk space

• Threshold level for each disk

Server Attributes

Server Attributes provides the following information:

• Host name and host domain

• IP address and whether DHCP server is enabled or not

• Apple Talk zone

• IPX setup & IPX printing (tree, context)
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Adding an External Device

To add an external SCSI device to the CSX2000 Color Server:

1. Verify that the CSX2000 Color Server is shut down.

2. If the CSX2000 Color Server is from serial numbers 002474-
002475 or from serial number 002478 onwards, loosen the 2 
screws and unplug the Termination of the CSX2000 Color Server 
located on the bottom rear end of the DFE. See the following 
figure and then proceed to step 4.

Rear of CSX2000 Color Server Showing Termination on I3

1. If the added external device is a disk it will be used for saving files and not for 
the application itself.

2. If you are adding an MO device, connect the adapter, and browse to: 
E:\Files_nt\Drivers\mo_drv and select setup.exe.

3. If the device is any other than an external disk, it is preferable to remove the 
Creo application prior to the installation and then reinstall it after the 
installation is complete.
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3. If the CSX2000 Color Server does not have Tag Matrix #4, order 
the following parts: Flat cable 68 Mini D-Type X3 Plg (Cable – 
SCSI Disks; System) p/n 117N01567, Terminator 68 MLVD/ single 
end W p/n 115N00355.

Next, perform the following:

• Remove the front panel (refer to the CSX2000 Color Server 
Technical Guide for details).

• Remove the right outer side cover (refer to the CSX2000 Color 
Server Technical Guide for details).

• Remove the side support bar (refer to the refer to the CSX2000 
Color Server Technical Guide for details).

• Disconnect the internal SCSI cable from the CPU, VPM, 
System disk and remove it from the system.

• Remove the metal cover from I3 using a screw driver and a 
hammer, insert the new SCSI cable and connect it to the CPU, 
System disk. Connect the metal connector to I3 using the 
supplied screws. 
See the following graphic.

• Return the side support bar, the right outer side cover and the 
front panel.

The configuration of the unit has been changed to Tag Matrix #4. 
Mark off Tag Matrix #4 on the CSX2000 Color Server.

4. Connect the external SCSI cable to the SCSI external outlet (see 
the above drawing) and to the external device.

5. Connect the device to the external SCSI connector on the 
CSX2000 Color Server, and verify that the device is defined as 
ID1 or higher.

6. Turn the external device power on.

The terminator will be required If the external device is disconnected. In this 
case, the terminator will be connected instead.

When the external device is disconnected, connect the external termination 
to the external SCSI connector.
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7. Turn the CSX2000 Color Server power on and wait for the 
operating system to initialize.

8. Click the Start button, and follow the path: 
Programs>Administrative Tools>Disk Administrator.

If the external device includes drivers, it is recommended to install them now.
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The following message appears.

9. Click OK.
The following Confirm message appears.

10. Click Yes.
The Disk Administrator window appears.



The external device is disk 1 in the hatched area. In case the 
external media is not new, disk 1 will not be hatched since it has 
already been formatted. In this case, just verify that the drive letter 
of disk 1 is other than E and ignore the following procedures. If the 
drive letter of disk 1 is E, perform the procedure for changing the 
assigned drive letter on page 225.

Note that the screen captures in this procedure reflect the disk status using a 
600/700 MHz CPU. If the CSX2000 Color Server has a 1 GHz CPU, the disk 
order is different: the first 2 disks are Image Disks and the third is the System 
disk.
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To format the external media:

1. In the Disk Administrator window right-click Disk 1 and from the 
menu, select Create.
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The Create Primary Partition window appears.

2. Click OK.
The Confirm window appears.

3. Click Yes.
The disk is now created.

4. Right-click the disk and from the menu, select Commit Changes 
Now.
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The following Confirm message appears.

5. Click Yes.
The following message appears.

6. Click OK.
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7. Right-click the disk and from the menu, select Format.
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The Format F:\ window appears.

8. From the File System list choose NTFS.

9. In the Format Options area, select Quick Format, and then click 
Start.
The format warning appears.

10. Click OK.
The following message appears to inform you that the format 
process is complete.
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11. Click OK.
The Format F:\ window appears.

12. Click Close.
The Disk Administrator window appears.

Before closing the window, verify that the CD-ROM drive letter is E. If 
it is, close the Disk Administrator window. 
The external device is now formatted and ready to use. 
In any other case, perform the following procedure.
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To change the assigned drive letter:

1. Right-click disk 1 (external device) and select Assign Drive 
Letter.

The Assign Drive Letter window appears.

2. Verify that Assign Drive Letter is selected, and from this list 
select any available letter. Then click OK.
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3. A confirmation message appears, click Yes to confirm your choice.

4. Right-click the CD-ROM drive and from the menu, choose Assign 
Drive Letter.

The Assign Drive Letter window appears.

5. Verify that Assign Drive Letter is selected, and from this list 
select E.

6. Click OK.
A confirmation message appears.

7. Click Yes.

8. Close the Disk Administrator window.
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Overview
This appendix describes how to configure the connection between a 
Novell NDS (Novell Directory Services) Server and the CSX2000 
Color Server, in a Novell working environment. 

To configure this connection, the following procedures are preformed:

1. Creating the Novell NDS Print Server  "nwprintserver" in the 
Novell NDS.

2. Creating a Novell NDS Printer object in the Novell NDS.

3. Creating the Print Queues <hostname_ProcessPrint> and 
<hostname_ProcessStore> in the Novell NDS.

4. Verifying the connection information.

5. Configuring the IPX Printing parameters: Tree and Context, using 
the CSX2000 Color Server Admin tool (General SetUp/IPX 
Printing) in the CSX2000 Color Server.

6. Installing the Printer Drivers on a Novell Client.

To perform these procedures, you need:

• Administrative permissions assigned by the Novell Administrator.

• The User Name and Password for access to the Novell NDS 
Server.

• An account in the appropriate NDS Tree and Context with 
permissions to create objects.

• The full Context (location in the NDS Tree) where you will be 
creating the Print Server, Printer and Print Queues.

• Background and know-how of Novell NDS Server.

Both <hostname_ProcessPrint> and <hostname_ProcessStore> queues 
should be defined even if you plan to use only one Printer queue.

All the above procedures should be performed on a Windows client running the 
Novell Client, and configured by the Novell Administrator to access the 
NWAdmin program.
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Defining Novell NDS Printer Queues in the Novell NDS Tree
Using the Novell NetWare Administrator Application

Perform the following procedures to create the Print Server, Printer and 
Print Queues, using the NWAdmin application:

1. Define the Novell NDS Print Server, Printer and Print Queue in the 
Novell NDS Tree.

2. Assign the Printer to the Print Server and the Print Queues to the 
Printer. 

3. Check the Print Layout to verify the connections and perform a test 
Print.

Perform the following procedures in order.
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To open the Netware Administrator Application:

Open the Netware Administrator Application (provided by your 
Novell Administrator or browse to Novell Server\Novell host 
name\sys\public\win32\NWAdmin32.exe.)

The NetWare Administrator window appears displaying the Novell 
NDS window. The following example shows the existing Trees, 
Queues and other Novell connections.
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To define a Novell NDS Print Server:

1. From the Novell NDS window, select the required Context.

2. From the Object menu, select Create.
The New Object dialog box appears.

3. From the Class of new object list, select Print Server.

4. Click OK.
The Create Print Server dialog box appears.

Before performing the following procedure, check the Novell Server window and 
if the nwprintserver already exists, proceed to the next procedure “To define a 
Novell NDS printer:” on page 233.

In Novell v5.0 NDS, the words “Non NDPS” also appear.
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5. In the Print Server name box, type “nwprintserver”.

6. Click the Create button.
The Novell NDS nwprintserver printer is created and appears in 
the Novell NDS window.

.

Notes:
1. It is important to use only this server name, in lower case. 
2. In any case, do not define a password for the Print Server.
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To define a Novell NDS printer:

1. From the Object menu, select Create.
The New Object dialog box appears.

2. From the Class of new object list, select Printer.

3. Click OK.
The Create Printer dialog box appears.

4. In the Printer name box, type any printer name, for example 
CSX_Printer.

5. Click the Create button.
The printer name is added to the Novell NDS window.

In Novell v5.0 NDS, the words “Non NDPS” also appear.
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To define the Novell NDS Print Queues:

1. From the Object menu, select Create.
The New Object dialog box appears.

2. From The Class Of New Object List, select Print Queue. Then, 
Click OK.
The Create Print Queue dialog box appears.

Important: 
1. Both <hostname_ProcessPrint> and <hostname_ProcessStore> queues 

should be defined. 
2. Prior to performing this procedure, verify that in the CSX2000 Color Server, 

both network printers <hostname_ProcessPrint> and 
<hostname_ProcessStore> are present.

3. Both Virtual printers <hostname_ProcessPrint> and 
<hostname_ProcessStore> should not be deleted from the CSX2000 Color 
Server.
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3. Verify that Directory Service Queue is selected.

4. In the Print Queue name box, type the exact (case sensitive) 
Virtual Printer name: <hostname_ProcessPrint>.
For example: CSX7_ProcessPrint.

5. Select the Create another Print Queue check-box.
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6. Click the Print Queue Volume icon.
The Select Object dialog box appears.

7. Select any existing volume.
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8. Click OK.
The Print Queue volume name appears in the Print Queue 
Volume field, in the Create Print Queue dialog box.

9. In the Create Print Queue dialog box, click the Create button.
The Print Queue is now added to the Novell NDS window along 
with the nwprintserver and the Printer name (CSX_Printer).

10. In the Create Print Queue dialog box, verify that Directory 
Service queue is selected.

11. Clear the Create another Print Queue check-box.

12. In the Print Queue name box, type the exact (case sensitive) 
second Virtual Printer name: <hostname_ProcessStore>.
For example: CSX7_ProcessStore.

13. Click the Print Queue Volume icon.
The Select Object dialog box appears.

14. Select any existing volume.

15. Click OK.
The Print Queue volume name appears in the Print Queue 
Volume field, in the Create Print Queue dialog box.

Notice that the Create Print Queue dialog box re-appears in order for the 
second Print Queue to be defined.
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16. Click the Create button.
Both queues appear now in the Novell NDS window.
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To assign a Printer name to nwprintserver Print Server:

1. In the Novell NDS window, double-click nwprintserver.
The Print Server dialog box appears.

2. Click the Assignments button to open the Assignments tab.
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3. Click the Add button.
The Select Object dialog box appears.
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4. From the printers, select the printer name you have defined 
(CSX_Printer in our example), and click OK.
The printer appears in the Printers list in the Print Server dialog 
box.

5. Click OK.
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To assign a Print Queue to the Printer:

1. In the Novell NDS window, double-click the Printer name you have 
defined (in our example CSX_Printer).
The Printer dialog box appears.

2. Click the Assignments button to open the Assignments tab.
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3. Click the Add button.
The Select Object dialog box appears.

4. Select the Queue name <hostname_ProcessStore> you have 
defined, and click OK.
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5. Click the Add button and select <hostname_ProcessPrint>.
Both printer queues now appear in the Print queues list in the 
Printer dialog box.

6. Click OK.
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To verify the new Novell NDS layout:

1. In the Novell NDS window, double-click nwprintserver.
The Print Server dialog box appears. 

2. Select the Print Layout tab.

3. Verify that the nwprintserver server, the printer and queues are 
displayed as shown in the above example.

4. Click the Cancel button.
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Using the Novell NDS PConsole 

The CSX2000 Color Server Virtual Printers can be defined as Novell 
NDS Printer Queues at the Novell NDS Server, using the Novell NDS 
PConsole. This procedure includes the following stages:

To use the Novell NDS PConsole:

1. In the CSX2000 Color Server, verify that the two Virtual printers 
<hostname_ProcessPrint> and <hostname_ProcessStore> are 
present.

2. In the Novell NDS PConsole:

• Create the Novell NDS Print Server  "nwprintserver".

• Create the Novell NDS Printer object.

• Create the Novell NDS Print Queues <hostname_ProcessPrint> 
and <hostname_ProcessStore>.

3. In the CSX2000 Color Server:

• Configure the IPX Printing parameters: Tree and Context (the 
exact tree name and the full context path name) using the 
CSX2000 Color Server Admin tool (General SetUp/IPX 
Printing).

• Restart the CSX2000 Color Server Application.

4. Install the Novell Printer Queue on the Novell Client, “Installing 
the Printer Drivers on a Novell Client Using the Adobe PS 
Application” on page 249

Notes:
1. It is important to use only this server name, in lower case. 
2. In any case, do not define a password for the Print Server.
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Configuring IPX Printing
To setup the CSX2000 Color Server IPX parameter:

1. In the CSX2000 Color Server, open the CSX2000 Color Server 
Software Application, and click the Admin button.
The Administration window appears.

2. Double click General Setup to expand the folder.
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3. Double click IPX Printing.
The IPX Printing dialog box appears.

4. Type the exact Tree parameter and the full containers path of the 
Context parameter, in their respective boxes. 

5. Restart the CSX2000 Color Server Software Application.

 These names are case sensitive and cannot be changed later on.
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Installing the Printer Drivers on a Novell Client Using the 
Adobe PS Application

To install the printer drivers on a Novell Client:

1. Use the Adobe PS Application with the CSX2000 Color Server 
PPD (provided in the CSX2000 Color Server, Utility folder). 

2. In the Adobe PS Wizard, verify that you have selected the Novell 
Printer Queue from the NetWare Network, and not the CSX2000 
Color Server Virtual printers. See the following example.
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Following is an example of the Printers window after installing the 
Novell Printer Queue.

3. Perform a test print using the installed Novell NetWare printer.

Note that the Novell Printer has the Novell NDS name as an extension, e.g. 
NW_TANSRV5.

For more information on preforming test prints, refer to the CSX2000 Color 
Server Printing Guide.
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Defining the CSX2000 Color Server as a Novell NDS Client
The following procedure is performed only to connect the CSX2000 
Color Server to Novell NDS, as a Novell client. You do not need to 
perform this procedure in order to print to the CSX2000 Color Server.

To define the CSX2000 Color Server as a Novell NDS Client:

1. Right-click Network Neighborhood icon on the CSX2000 Color 
Server desktop, and from the menu, select NetWare Login.
The Novell Login dialog box appears.

2. Type the Username and Password in their corresponding boxes; 
this information is available from your Novell Administrator.

If the connection between the CSX2000 Color Server and the Novell Server has 
already been defined, verify the connection by following this procedure.
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3. Click the Advanced button to expand the dialog box.

4. In the NDS tab, click the Tree icon.
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The Tree window appears.

5. Select the required tree and click OK.
The tree parameter will now appear in the Tree list in the NDS tab.

6. In the NDS tab, click the Context icon.

An optional way is to type the exact Tree name, the Context full container 
path and the Server exact name, in their corresponding boxes. These 
names are provided by the Novell Administrator.
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The context window appears.

7. Select the required context full containers path, and click OK.
The Context parameters full containers path will now appear, in 
the Context list in the NDS tab.

8. In the NDS tab, click the Server icon.
The server window appears.



Defining the CSX2000 Color Server as a Novell NDS Client 255
9. Select the required Server, and click OK.
The Server parameters are added to the Server list in the NDS tab.

10. Click OK in the Novell Login dialog box.
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A Results window appears briefly to indicate that the connection 
was successful. If an error message appears instead, contact your 
Novell Administrator.

The CSX2000 Color Server is now defined as a Novell NDS client.
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